Mold Monitoring System

User Manual
Table of Contents

Remote Control Unit          Page. 3
Main Control Unit            Page. 4
IS-Series Cameras            Page. 5
Variable Zoom Lens           Page. 6
Startup Procedure            Page. 6
Shutdown Procedure           Page. 7
Camera Setup Instructions    Page. 7
GUI Introduction             Page. 7

Inspection / Search Region Setup Instructions        Page. 8

Picture 1 Status              Page. 9
GUI Status Lights             Page. 10
Saving Jobs to Camera         Page. 10

Setting Jobs to Automatically Load at Startup        Page. 11

Recording Images              Page. 11
Interface Wiring              Page. 13
System Maintenance            Page. 13
Troubleshooting               Page. 13
Replacement Parts             Page. 15
Remote Control Unit

(Located Below PC & Above Mouse Pad)

The remote control unit houses the main operator control components of the mold monitor system. This includes the power switch, timer, reset button, and a 6 pin plug for the cameras power/communication cable. The power switch and 6 pin plug are located on the back of the remote control unit while the time is on the left and the reset button is on the right.

- **Power Button**: This is the main power switch. As long as the system is plugged in to 110V this power switch will turn the Mold Monitoring System on or off. *It is important not to turn the power switch off while the PC is still powered on. Shutdown the PC before powering off the Mold Monitor System.*

- **Timer**: The timer is what allows you to adjust the time between the first and second picture. *This will also directly affect the cycle time of the machine.* Allow just enough time for the part to be ejected/removed before triggering the second picture. If you are noticing that the second image is catching the runner or sprue picker in the image, add a little more time. The timer
should always be left in “Mode A”; the “Range” should remain in “Sec” for seconds, but if
needed could be switched to minutes, hours, or hours as well. The scale allows you to adjust the
time range that is selectable on the dial. The default from A.S.K. Technologies is “2, 4, 6, 8”
seconds.

- **Reset Button**: The reset button is used to reset the system when a bad image is captured.
  Pressing the Reset button will permit the mold to close and continue production. *The Reset
  button should only be pressed after an operator has inspected and removed any stuck parts or
  debris from the mold.*

- **Camera Power**: The 6 pin camera power plug provides power to the camera and allows the
camera to communicate with the Mold Monitor System. *Do not unplug the Camera Power
  Cable at ANY time while the Mold Monitor System is powered ON.*

### Main Control Unit

The main control unit contains all of the main control components for the Mold Monitor System.
Coming out of the main control unit are 4 cables: 110V Power, Remote Interface, Interface, & PC
Power. As well as the 4 cables, there is also a 2 amp fuse on the lower left side of the box and a
red power light on the upper right side of the box. If the system is plugged into 120V but will not
power up when you turn the power switch on, check the 2 amp fuse to make sure that it is still
good.
- **110V**: The 110V cable is the “Main Power” supply. For the system to power up & function this must be plugged in.

- **Remote Interface**: The remote interface cable connects the Remote Control Unit to the Main Control Unit and allows for power and I/O communications to be sent between the two.

- **Interface**: The interface cable is what gets wired into the press and allows the Mold Monitoring System to communicate with it. This cable is what sends and receives signals to trigger the cameras and also open or close the clamp of the press. *See page 11 for wiring diagram*

- **PC Power**: The PC Power cable provides power to the PC.

### IS-Series Camera

This is the IS-Series Camera. It has two threaded plugs on it, one for 24V power and I/O communications, and one for Ethernet communication for connecting to a PC. Both are labeled on the front of the camera. The IS-Series Camera comes with an integrated red led ring light. This helps save space and minimizes the cost for external lighting solutions. If the integrated ring light is not sufficient for a specific application, A.S.K. Technologies can assist in finding and
supplying the appropriate light to accommodate the application. The IS-Series Camera includes a hard metal casing to prevent damage from being in hot and/or dirty environments.

**Variable Zoom Lens**

The OEM lens is a C-Mount type. It has a variable zoom from 6mm – 15mm. The lens also has the option to open or close the iris. This will allow the person setting up the camera and lens more adjustability when determining the correct brightness level. The manual focus control at the front of the camera allows for fine adjustments to be made to make the image as clear and focused as possible. Color and Polarized filters are available for purchase through A.S.K. Technologies.

**Startup Procedure**

1. Be sure that both camera power and camera Ethernet cable are plugged in and threaded down tight to the camera. Connect the other end of the Ethernet cable to the computers Ethernet port, located on the back of the PC. Connect the female 6 pin from the camera power to the male 6 pin labeled “Cam Power” and located on the back of the Remote Control Unit.
2. Make sure the switch on the back of the Remote Control Unit is set to the “OFF” position. Plug the Main Control Units 110V plug into a 110V outlet.
3. Turn the power switch on the back of the Remote Control Unit to the “ON” position. The red power light located on the right side of the Main Control Unit should illuminate.
4. Turn the PC on by pressing the power button. The In-Sight Explorer Software will automatically start once the PC has fully booted up. The system will also automatically start the camera “Online” and load whichever job is currently set to load at startup. *See page 11 for instructions on how to change which job is loaded upon system startup.*

**Shutdown Procedure**

1. To shut down the Mold Monitor System you **must** first shut down the PC! To do this click the “Start / Windows” button in the lower left corner of the screen. Select “Shut down” from the menu.
2. Once the PC has fully shut down and the power light on the front has turned off it is now ok to turn off the main power to the system. Flip the power switch located on the back of the Remote Control Unit to the “OFF” position.

**Camera Setup Instructions**

1. Once the system is powered up for the first time or after a mold change the camera will need to be setup and focused to be sure that it is operating correctly. The first step to do this is to take the system “Offline” by clicking this button and confirming the offline transition.
2. Now that the camera is offline it can now be put into “Live Mode” by clicking this button. This will give you a live image of what the camera is seeing. You can adjust the cameras’ position, angle, zoom, iris, and focus while this view is active. Try to focus the camera as clear as possible on the areas being monitored as this will make the system more reliable. *This step should be performed while NO parts are in the mold.* To exit “Live Mode” simply click anywhere on the screen or click the “Live Mode” button again.
3. Once you have the camera setup and focused place the camera back “Online” by clicking the same button and confirming the online transition.

**GUI Introduction**

![GUI Image]

Above is the GUI (graphical user interface). This will be on-screen at all times and is the operators control panel. From the GUI you can adjust the cameras exposure, turn certain windows on or off, you can move and adjust the size of the inspection / search regions, you can “Train” your “master image”, and you can check the score and status of your windows you set up. We also included and overall pass / fail status light. *Always be sure that the GUI reads “Cycle Ready” and the status light to the left of it is green before starting a cycle.*
- **Trigger**: The “Trigger” button will manually trigger the camera. This can only be performed while the system is offline. This is to prevent the camera from accidently being placed “Out Of Cycle” while in production. This can be used when trying to acquire an image to setup your search windows instead of placing the system into “Live Mode”.

- **Adjustable Cell below “Trigger”**: This is the camera’s exposure setting. It is measured in milliseconds (ms). This controls how long the camera’s sensor stays “open” and allows light onto the sensor. Generally a higher exposure number will brighten the image. This is helpful when trying to inspect very dark parts in a very dark environment. On the opposite end of the scale a lower exposure number will produce a darker image. This could be useful when trying to inspect a white colored part in a mold with a lot of reflection. Keep in mind that the higher the exposure is set and the longer the sensor is “open” the more affected the image will be by motion and shadows.

- **Window**: This button will allow you to turn certain search windows on or off. There are a total of 16 windows that can be configured.

- **Setup**: This button will allow you to adjust the size and location of the search window(s) you decide. Double click the center of the window once it is in the desired position to exit and continue to the next search window. Press “OK” when finished positioning all search windows to accept changes, or press “Cancel” to discard any changes made. *Any time there is an adjustment made to window size or position the system will need to be “trained” again.*

- **Train All**: The “Train All” button allows you to “train” the master image. The system should only be trained when there are **NO** parts in the mold.

- **Pic 1 Status**: This is where the values of each search region can be read and their acceptance thresholds adjusted. For the 1 picture system the picture is looking for whatever is trained in the master image. If the camera detects a change in the current image to the master image it will score it based on the similarities to the master image. If the score falls below the threshold, the image is considered bad.

- **Reset Checkbox**: Checking the “Reset” checkbox and the unchecking it will place the system back to a “Cycle Ready” state. This is where the system needs to be before starting to run a cycle. Leaving the “Reset” checkbox checked will override the system and allow the press to run regardless of what the Mold Monitor System tells it. *While the “Reset” box is checked the mold is **NOT** protected!*

---

**Inspection / Search Region Setup Instructions**

1. Before making any program adjustments or changes the camera must first be taken “Offline” by pressing this button and confirming the offline transition.
2. Click the “Windows” button on the GUI and verify that the correct number of search windows are turned on for the mold you are inspecting. Click OK to exit.
3. Click the “Setup” button on the GUI. An “Edit Regions” dialog box will open up.
4. Select which window you would like to position from the dialog box and a search region window will appear on screen.

5. Once you have positioned the region, double click to return to the “Edit Regions” dialog box and continue positioning the remaining search windows.

6. Once you have finished positioning all of the windows you will be using press OK to exit the “Edit Regions” dialog box. Pressing Cancel will discard any positioning changes you have just made.

7. Now that you have moved the search window positions you need to “Train” the system. This is done by clicking the “Train All” button on the GUI.

8. Save the job for easy setup next time you run the same mold again. The next time that mold you just setup is put back in the press for production simply load up the job you just saved and the windows will already be in the correct position. All you will need to do is train the system. *See page 10 for instructions on saving jobs.*

**Picture 1 Status**

Clicking the “Pic 1 Status” button will allow you to view the score returned for each search region and will also allow you to adjust the tolerances for each of them as well. The default tolerance setting is 70. When you initially setup the system and trained the search regions on the empty mold it set the “master image”, an exact match would be a score of 100. Each time the camera captures an image it is returning a score based on that trained image. For the picture 1, since there will be a part present in the mold, the score will be low or even zero. This is because it is not close to matching the trained image. For picture 1 the system is looking for a score LOWER than the set threshold for the image to be good. A score returned higher than the set threshold will mark that search region no good. To adjust the thresholds, find which region you would like to adjust and either use the up and down arrows or you can manually insert the number you desire from 1-99. Press ok to accept changes or press cancel to discard any changes. *For picture 1, the closer to zero the tolerance is set the more accurate the system becomes.*

**GUI Status Lights**

On the far right of the GUI there are two status lights. One for picture 1 and one for picture 2. These are the overall pass lights. If all the search windows are deemed as good the status for the picture will be “OK” and the light will be green. Should one, or all, of the search windows be no good the status will read “NG” and the light will be red. When either one or both pictures are “NG” the clamp will not close. The system will hold it open until an operator can inspect the region that was no good, alleviate the problem, and then press the green “Reset” button located on the Remote Control Unit to clear the error and start a new cycle.
Saving Jobs to the Camera

To save a job, while offline, click on “File” in the upper left corner of the screen. Select “Save Job As…” from the drop down menu. Be sure that you are saving the job on the camera and not on the PC. Jobs that are stored on the camera can be setup to automatically load when the software starts. Give the job a name (part number, serial number, date, product ID) and click Save.

To make sure you are saving the job to the camera and not somewhere one the PC, when you click the “Save As…” button this window will open. Select “In-Sight Sensors” from the list on the right. This will bring up a list of sensors connected to the system. Double click the sensor and then you will see a list of jobs saved on the camera. Now you can save the job and it will be stored in the camera's internal memory. If you have made only minor changes and do not wish to save the current job as a new revision you can simply click “Save” instead of “Save As…” *Anytime any changes are made to a job it is important to save those changes.*

Setting a Job to Automatically Load at Startup

Once you have some jobs saved in the camera internal memory, you can then select one of these jobs to automatically load when the software starts up. This will help eliminate costly setup time. To assign a job to start automatically take the camera offline. Select “Sensor” from the menu bar at the top of the screen. From there select “Startup…” This will open a new dialog box with a checkbox for confirm online or offline startup and also a dropdown box that will list all of the jobs stored in the cameras internal memory. Be sure that the “Online” box remains checked at all times. This will ensure that when the software starts the camera will be online and ready to run. Select which job you would like to have automatically load at startup from the dropdown box. Select OK when finished to save changes or cancel to discard any changes made.
**Recording Bad Images**

To record bad images to the PC for later viewing follow these simple steps. First you will need to create a new folder on desktop, name the folder “Bad Images”. While In-sight Explorer is open and the correct job is loaded, check to see if there is a red record button, near the “Live Mode” and “Online /Offline” buttons. If no record button is present, select “View” from the menu bar at the top of the screen, from there select “Toolbars” and then “Record / Playback”. Then you will want to click the small down arrow next to the record button and choose to “Add or Remove Buttons”. Remove all buttons except for the record button.

To setup image recording go to image at the top of the screen and select, “Record / Playback Options”. This will open a new window. Select the record tab on the top left of the new window that just opened. In the top box labeled “record folder” is where you will reference the new “Bad Images” folder you just created on the desktop. In the drop down menu labels “format” you want to select [Date Time], this will save the images by the date and time they were captured. Also be sure that the “Record zero or #ERR values to bad folder” is selected to the right of the window. The watch cell should be “K217”. To record all images select “Do Not Use Watch Cell (Record All to Record Folder)”.

Once you have confirmed that the Record Setup Screen above matches yours, you need to save the job. Select “File” from the top of the screen and choose, “Save Job”. Also save the layout so that the record button will stay where you added it. To do this select “System” from the top of the screen and choose, “Save Layout”. *Record button needs to be pressed only once at system startup, but needs to be done every time the system is shut down or turned off.*
Interface Wiring

NOTE: USE DRY CONTACTS FOR INPUTS, MOLD OPEN COMPLETE AND SAFETY GATE.
System Maintenance

A.S.K. Technologies Mold Monitor System is Maintenance Free aside from periodical cleaning of the Camera Lens and the PC screen.

Trouble Shooting

Q. The Vision system has a NG reading and there are no parts in the mold?
A. First, open the mold completely and press the “Train All” icon on the GUI.

Q. The system is still reading NG after retraining the search regions?
A. Open the status window and see which windows are failing, if all of the windows are failing it means that the camera is not in the right position, if only one window is failing check the tolerance on that window and adjust accordingly.

Q. The mold is half-way closed; I cannot get a good reading from the system?
A. Check the reset box on the GUI and press the reset button on the front of the controller, you will have control of the mold. Restart the cycle and when the mold has closed, uncheck the reset box.

Q. The system is not connecting to the camera?
A. Check all camera connections; make sure the both cables are hooked up correctly. Locate “view” dropdown at the top of the menu bar, and open the insight network. If the camera is showing double click it to connect. If camera is not showing up there is a connection problem, contact A.S.K. Technologies for further support.

Q. The mold is operating but the camera is not taking a picture?
A. The system needs to be online, by pressing this icon at the top of the shortcut menu bar. Be sure to confirm that you want to go online.

Q. The camera is taking pictures, but the integrated ring light is not working.
A. To turn the light on or off you first need to take the system offline. Once offline, if you have a keyboard connected to the PC you can just press F6, if no keyboard is connected then click the “View” dropdown menu bar at the top of the screen. Towards the center of the dropdown menu will be an option for “Custom View”. Click on “Custom View” and it will take you to a spreadsheet view. In the upper left of the spreadsheet you will see a cell with “Image” written in it, Cell “A:0” Double click on the “Image” cell and a new window will open. Scroll down in this new window until you see “Light Control”, click on the expand mark to the left of it. Once you expand the “Light Control” settings you will see “Light Enable 0” and “Light Enable 1” and next to each will be a box with a number in it. A zero indicates that the light will be turned off, and 255 indicates that the light will come on when the camera is triggered. Both “Light Enable 0” and “Light Enable 1” must be the same number value. Either both set to 0 for off or both set to 255 for on. Once you have set your light, on - 255 or off – 0, click “OK” at the bottom of the window and the window will close. With a keyboard either click F6 again to return to “Custom View”, or if no keyboard is connected click on the “View” dropdown menu and select “Custom View” again to return to the normal operating screen. Before putting the system back online, after any changes are made to the program it should be resaved. Click the “File” dropdown menu and select “Save”. After saving the changes to the program place the system back online and continue with normal operations.

Q. I need to save the changes I made in the vision system?
A. After you have made your changes you need to go offline by clicking the online/offline icon and confirm that you want to go offline, and then click on file>save.

Q. The image on the screen is not clear, how do I adjust the Focus and the aperture of the lens?
A. The system must be offline, click . To bring the camera into live mode locate the Live Mode icon. This will bring the camera into a live feed, after you are done adjusting the lens, press Enter and put the system back online.

Q. I cannot get the current readings of a window status to return a higher value than 70?
A. Turn the system offline, turn the Live Mode on, and adjust the Iris (contrast of the lens) exit live mode, and return the system online. Click the train all icon and check the status of windows to see if the values have changed.

Q. The camera is not connecting to the system when the PC powers up and the software has started.
A. Fist make sure the system is offline. Select “View” from the menu bar at the top of the screen, then click “In-Sight Network”. This will open the In-sight network tree. If a camera icon is shown
in network tree, double click it. Once the camera loads go back to “View” at the top of the screen and select “In-sight Network” to close the network tree. If no camera icon is shown in the network tree, select “System” from the menu bar at the top of the screen, and choose “Add sensor/device to network...”. Press refresh until the camera appears. You may need to cycle the power on your camera to complete setup. Once the camera icon appears on the add sensor screen click it once and click the “copy pc network settings” button. This will transfer some numbers up to the IP address and the subnet mask. On the IP address line delete the last number and change it to 10. The subnet mask should read 255.255.255.0 and everything else should be blank. Click apply once all the numbers match the image above. The camera will now show up in the network tree to the left of the screen. Close the add sensor screen, and double click the camera icon that appeared in the network tree. This will load the camera. Once the camera has connected and the system is in the custom view / running screen with the GUI showing, make sure the correct job is loaded. To close the network tree go back to “View” at the top of the screen and select “In-sight network”. Once you have closed the network tree you should re-save the layout. This is done by selecting “System” from the top of the screen and selecting choosing “Save Layout” from the list. If a “filmstrip” appears at the bottom of the screen it too can be turned off by going to “View” at the top of the screen and choosing “Filmstrip” from the list. Save the job to the camera. Place the camera Online and continue production. *If for some reason this does not help you and further assistance is required please feel free to contact our tech support at (714) 694-1992 ext. 205.*
Replacement Parts

CPU: ASK-CPU-MMS
CPU Power Supply: PS-CPU-ASK
Mouse: OM-5100
Mouse Pad: MP-5100
Mouse Pad Bracket: MPM-5100-ASK
Camera: IS-5400; IS-5401; IS-5403
Camera Bracket: CM-5100
Camera Light: RL-5100-LED
Camera Power Cable: CP-24
Camera Ethernet Cable: CE-5100
Reset Button: GCX5100
Timer: AT-5100-ASK
Power Switch: PS-110V
Fuse Holder: FH-2AMP-ASK
2 Amp Fuse: BUS-2-AMP
Power Light: PL-24V-ASK
Ergo Arm Swivel Mount: SA-5100

A.S.K. Technologies
22605 La Palma Ave. Suite 506
Yorba Linda, CA 92887
Phone: +1 (714) 694-1992